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With all the advances in modeling and animation, an often overlooked, but absolutely critical area of 3D scene creation is the 
proper use of lighting, material creation, and rendering techniques. Good lighting and rendering can make even a simple 3D 
model look extraordinary, and poor lighting can make even the best model look bland. In this series, we'll be covering not just the 
mechanics of lighting within the Autodesk XSI software package itself, but also how to incorporate the language of light used in 
fine art, theater, & film into your 3D scenes, to create truly cinematic views that are compelling for an audience. We'll explore the 
basics of real-world lighting scenarios and how to implement them in 3D, and since rendering is inseparable from lighting, we'll 
also discuss various rendering techniques such as Global Illumination, Final Gather, Ambient Occlusion, and of course, High 
Dynamic Range Imagery (HDRI) Lighting.
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Light & Shadow

In music, the silence in between the notes are as important as the notes themselves for creating emotion within a song. Similarly 
in lighting, shadows - their placement, direction, intensity, softness, etc. - are just as important as light, in creating meaning and 
mood within a scene (Fig. 1A-B). 

Fig 1. This still life demonstrates the importance of not just light, but shading to a scene. Notice that while the first image A) is well lit with Global Illumination 
and Final Gather rendering, it is still relatively flat. But with the addition of the directional shadows B) cast courtesy of the Physical Sky shader in XSI light 
passes through a window, a curtain, and shadows from the leaves outside, the scene gains additional visual interest and realism.

More often than not, beginners will often take one of two approaches, either flooding the scene with flat light as if merely seeing 
the objects is enough for the viewer (or worse, simply bumping up the ambience to fill in poorly lit areas), or not lighting it enough 
in order to hide shortcomings in modeling.

When used properly however, both light and shadow can actually enhance a model or animated character, providing an 
additional layer of drama or suspense to the scene. Obtaining an understanding of these basics is critical to realizing your vision.

Three-point Lighting

Three-point lighting is derived from a technique originally developed for theater by Stanley McCandless, who is widely 
considered the premiere developer of lighting design within the United States. The variation used in film, television, and product 
promotion for commercials utilizes three lights: a key light, a fill light, and a back light, each with a specific purpose.



The key light (Fig. 2A) is the main directional light on the object or character, and typically the brightest light source in the scene. 
The fill light (Fig. 2B) is used to simulate the light bounced from objects and sources on the opposite side of the frame from the 
key light. And lastly, the back light (Fig. 2C) is used mainly to separate the character or object from the background by providing 
a slight halo effect off the back edges of the character, such as a hint of light at the rim of their shoulder, or off edge of their hair. 
Back light is not the same as background lighting however. Three-point lighting is about illuminating the main subject, whether 
that's a character, or the model of a product, a company hopes to sell. Therefore back lighting points toward that subject, not the 
objects behind that subject.

Fig 2. These images show a standard three-point lighting set-up. Note how the rays are cast in order to light both the figure, and to differentiate the subject from 
it’s background. A) Key Light. B) Fill Light. C) Back Light.

There is another handy tool for positioning your lights within XSI. By clicking on the dropdown arrow of any 3D viewport you can 
select "Spot Lights" then choose any of the listed spot lights within your scene. The view will change to the perspective of the 
light itself (Fig. 3), as if you were looking through it, directly at the object it is lighting. From here you can see precisely how much 
of the object is receiving light, and where the umbra begins. You can also interactively adjust the spotlight by pressing the "b" 
hotkey to display the light's manipulators and pressing Tab to reveal the manipulators for the cone and spread angle of the light. 
The white exterior cone controls the Cone Angle value and the inner yellow cone determines the Cone Spread value. Simply 
click and drag the cone you with to adjust, or Shift-click as drag the edge of the cone to manipulate both cones simultaneously.

Fig 3. XSI’s Spot View

Key-to-Fill Ratios

The main thing that key-to-fill ratios (Fig. 4A - D) determine within a scene, is how contrasty your final image will be. Low key-to-
fill ratios are excellent for creating desaturated looks such as those of a cloudy day where the sky is overcast and is muting any 
harsh directional light from the sun, or in places where there is a lot of bounce light from the surrounding environment such as a 



hospital room or the white tile of a kitchen. Low key-to-fill ratios are also used for any atmosphere where one wants to create the 
impression of happiness, such as in a kid's room. In this sort of lighting scheme, there is a great deal of fill light nearly matching 
that of the key light.

Fig 4. Here are series of images demonstrating a range of lighting possibilities. The first image A) presents a standard lighting scheme, the next B) shows a low 
key-to-fill ratio, then C) a more dramatic high key-to-fill-ratio. The last image D) demonstrates how a change of angle can alter both the emotional character of 
the subject making him look quite ominous, and even seems to change the structure of the face.

Examples of high key-to-fill ratios would be scenes with deep shadows and bright highlights, such as the stark lighting of film noir 
classics such as Touch of Evil, scary films like Les Diaboliques, or in the paintings of Rembrandt. In this kind of lighting, the key 
light is often set at a very high angle, producing sharp shadows and a triangle of light below the eye of a character on the 
opposite side of the face from the key light position. It is highly directional, and there is virtually no fill light on that side.

Color Temperature

Color can modify form, and is a powerful visual and emotional stimuli within a design that can cause objects or characters to 
appear to change dimension, reverse directions, and alter the interval between forms. It can even seem to generate motion 
within a scene independent of object animation. The colors you choose within your lighting establish overall mood, and reinforce 
the theme of the overall work.

Color temperature (measured in degrees kelvin) varies depending upon the light source in question. All objects emit light when 
sufficiently heated. The degree of brightness is a function of temperature. Through a device called a spectrophotometer, any 
color can be equated with the amount of temperature being applied to a blackbody, which results in a Kelvin measurement (Fig 
5). Candlelight is very warm in color and  varies between 1850-1950 degrees Kelvin, whereas a typical household incandescent 
light is about 3000K, producing a lightly warm color ranging between orange and yellow. Fluorescent lights give off cooler color 
tones ranging from green to blue and are between 3200K and 7000K. Daylight ranges between 5500-7500K.

Fig 5. Color Temperature Chart in Degrees Kelvin



A user's color choices in lighting are also important when trying to composite 3D objects or characters with live action 
backgrounds. Films also are registered to certain color temperatures, daylight balanced film is 5500K and tungsten-balanced film 
is 3200K. Even today's digital cameras use filters to achieve the same sort of effects, and on-set lights use specific gels to tint 
light sources, so if you're working with photographers or cinematographers, you're going to need to get that shooting data from 
them if you're going to mesh your scene well with their work. Additionally, post-production color timing used by film processors 
can also change the scenic color balance.

Adjusting Gamma Correction & Contrast

Gamma measures the degree of brightness and contrast within the midrange luminance values of an image (Fig. 6), either in a 
photograph, or via a video or computer device. When video is encoded and decoded, variations in the contrast values of the 
image occur. In a typical cathode ray television, the gamma is 2.2 darker than the original 1.0 gamma value of the video 
compression recorded by a camera. Additionally, there are differences between Windows and Mac systems, with Windows 
gamma encoding being 0.45 and the gamma decoding being 2.2. Mac OSX and later encode gamma values at 0.55 and decode 
gamma at 1.8. A Nintendo Game Boy displays images with a gamma value ranging from 3.0 to 4.0.  

Fig 6. This series of images of a blue frog demonstrates how gamma effects an image. The second image from the left should be ideal for most 
devices. (Photo Credit: Lucy Burton)

What all this means in practical terms for the 3D artist, is that the output gamma values of your project needs to be adjusted 
depending upon what sort of display your project is likely to be viewed on.

Within XSI, you can adjust the gamma values for a render pass by opening the Render Manager in the Render Toolbar, and 
selecting Pass > Edit > Edit Current Pass or Render > Render > Pass Options. Within the Pass Gamma Correction option, you 
can enable "Apply Display Gamma Correction".

Users can also edit the gamma of an image clip used either as a material, light, or environment texture, simply by selecting the 
geometry or light in question and choosing Modify > Texture and electing the relevant image clip from the submenu listings, or by 
double-clicking on the image clip you wish to alter from within XSI's RenderTree. 

From there you can alter the HDR or OpenEXR Display Gamma settings for your particular display, as well as altering the Color 
Profile Gamma either as an sRGB preset, or with your own User-defined gamma settings. OpenEXR and High Dynamic Range 
images have linear color profiles, Cineon and DPX images are logarithmic and therefore are automatically converted to a linear 
profile. Any 8-bit image is regarded as sRGB. You'll notice that within this dialog box, users can also control F-stop Exposure, 
and Color Correct for Hue, Saturation, Gain, and Brightness with value sliders. Additionally, all parameters can be animated as 
well, by setting keys via the green animation curve marker to the left of each option.

Alternately, users can correct gamma values globally during the compositing phase, via a Color Adjust Operator with XSI's 
custom compositing application, the FXTree. This integrated system within XSI is based upon the Avid Media Illusion toolset, and 
has become increasingly powerful as versions have progressed.



Inverse Square Law: Light Intensity Attenuation/Falloff

The Inverse Square Law of light states that as light waves radiate outward from their source, the intensity of that light decreases 
in inverse proportion to the square of the distance from the source. In other words, an object twice as far away from a light, 
receives only one-quarter the intensity of that light as exists at it's origin.

Light attenuation or disambiguation/falloff describes the gradual diminishing intensity as light moves through any medium, be it 
air, water, glass, or through subsurface scattering such as that found in porous surfaces like marble or skin. Such light scattering 
can be simulated in 3D via lights and material shaders.

Some light shaders use a linear fall-off value, however linear falloff tends to look less realistic, and if the wrong value is input, 
visible noise results because it actually makes the computer violate a natural law - namely conservation of energy - and ends up 
producing hot spots of intense light in random places within the scene. 

It is far better to use the Light Exponent Falloff Mode and manipulate the inverse square fall-off of the light source and fine tune 
the exponent values from there, as these examples show (Fig. 7A-B).

Fig 7. In these two images, the physical distance between the light and the object have not been changed. 
Only the light exponent start/end falloff values have been altered, therefore, the light's brightness in the first 
image diminishes before it can cast a full oval of light onto the table. Additionally, you'll note that in the first 
image,  A) the shadow cast by the pottery is much sharper. That is because in that image, the shadow was 
generated via raytracing, whereas in image B) the soft shadow is achieved by creating a shadowmap. 

Depth of Field

The human eye, unlike a computer, cannot focus all objects to infinity, and so in order to add more realism to a scene, adding 
depth of field is an important option, though it can be a render intensive one. Depth of field settings simulate a plane of maximum 
sharpness, and  corresponding areas surrounding that plane which are also in focus (commonly referred to as the "circle of 
confusion"), while increasingly blurring objects beyond this area. The settings work the same way as they do on a real camera 
when the aperture dilates to let in varying levels of light.



By varying the combination of aperture size/F-stop and shutter speed, cinematographers also control the depth of field in an 
image. A high F-stop/small aperture combined with a slow shutter speed yield a wide area of prime focus, or a large circle of 
confusion. A low F-stop/wide aperture diameter combined with a fast shutter speed yields a narrow area of prime focus, or a 
small circle of confusion.

A Depth of Field effect can be simulated in 3D with a lens shader applied to the camera (Fig. 8). This cityscape demonstrates 
how to achieve a common film technique known as a “rack focus”, where the area of prime sharpness moves from the 
foreground to the background or vice versa. One might use this method to keep a person in focus while walking through the 
cityscape towards the camera, in order to keep the audience's attention on that character. 

Fig 8. In the top image, A) a lens with a focal length of 80mm is used at f32, with a narrow circle of confusion 
(0.1), and a focal distance of 70. In the second image, B) the lens is still an 80mm, but the F-stop setting has 
been changed to f2. In both cases, the Depth of Field Strength is set at 0.07. To animate this effect, one would 
simply set keys on the focal distance and F-stop in frame 1 using the first values, and then advance the timeline 
to frame 60 and set another key with the second set of values, thereby creating a 2 second rack focus effect at 30 
frames per second (fps).

However, effects executed via 3D shaders within the scene such as the one above, can be extremely render intensive. A time-
saving alternative is achieved via an output shader such as the Mental Ray 2D Depth of Field shader applied at the pass level, 
which uses z-depth information obtained during rendering to generate a global blurring effect in a post-processing calculation 
within your composite (Fig. 9A). 



Fig 9A. Post processing a Depth of Field effect via the FX Tree Nodes.

Once a separate Depth Pass has been rendered, an image is created that contains information regarding the relative z-depths of 
all the objects in your scene. With that, you can go into the FXTree and plug in the relative nodes to achieve the desired effect. 
The nice thing about this method within XSI, is that by simply passing your mouse over the composited image in the FX Viewer, 
the application will return a precise distance value to any object you point at, so that you can enter the relevant focus values into 
the Depth of Field Parameters. 

In terms of render time, the image below (Fig. 9B) rendered basically in real-time, virtually instantly, despite being a much more 
complex scene, with more geometry along with complex textures and displacement effects. So this is something to consider 
when planning your production workflow.

Fig 9B. Final render of a composited Depth of Field effect.

Summary

Successfully working with complex 3D software packages like XSI, is largely about balance and selectivity, making conscious 
choices about what effects to apply where, and what to leave off. 3D is ultimately about problem-solving, case-by-case. This is 
why 3D is as much art, as it is science, and a challenge to both right-brain creative artists and left-brain technical specialists. It's 
also why it's so fun.

In upcoming articles, some specific techniques within the XSI software package will be demonstrated. These will include how to 
use particular types of lights in combination with various shaders and textures, demonstrate motion blur, discuss the 
complexities of glows and volumetrics, show how to create light rigs, animate lights, and discover how XSI mimics the physics of 
light within a 3D scene to create realism. Finally, we'll discuss the range of rendering strategies & optimization techniques that 
users can implement.
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